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1. Introduction 
 

TagBase is ideal for 

 

• Centralizing tag data within a unified relational model 

 

• Integrating with metadata and auxiliary data 

 

• Querying data efficiently (subset, regroup, summarize) 

 

• Visualizing data rapidly (e.g. forms with MS-Graph) 

 

• Integrating with other tools as a backend database and manage result outputs 

 

TagBase is a relational database application for the management of output files from 

manufacturer’s post-recovery or post-reporting software. TagBase implements a 

comprehensive relational model handling both archival and pop-archival satellite tag files 

from all major tag manufacturers. Implemented in Microsoft Access, this application can 

be easily ported to a variety of database management systems across platforms. 

Highlights of the current TagBase implementation include automated importation of tag 

files, data summary forms, extensive plotting capabilities, and flexible export of tag data 

to other applications for further analysis. 

 

Limitations  

 

TagBase is geared towards maintaining post-manufacturer processed data files for display 

and analysis. By default, most of the hardware status messages will not be assimilated. 

Examples of hardware messages include the RawData worksheet from Wildlife 

Computer PAT tag files (.xls), “Light too dim” data column for Lotek Wireless Archival 

tag files (.csv), or, “Wet/Dry State” for Wildlife Computers Archival tag files (.csv).  

 

It is highly recommended that you always adopt the practice of archiving raw files, 

including files that are downloaded from the tag directly and output files after processing 

with manufacturer’s software suite. Then use TagBase to maintain data that are quality 

control and carefully maintained for data visualization and analysis purposes.  

 

Where necessary, a very simple, separate database can be developed to keep track of 

archived raw files in relation to data residing in TagBase. 

 

Lastly, when you need to a large number of tags (more than 1 Gb), it will be more 

efficient to implement TagBase in a high-end database management system, rather than 

what it is now in Microsoft Access. 

 



Disclaimer  

Please understand that TagBase is still currently under development. And we appreciate 

all comments, inputs to making TagBase a better tool. 

 

Contact Information 

 

Tim Lam 

Marine Environmental Biology 

3616 Trousdale Pkwy, AHF 107 

Los Angeles, CA 90089 

http://netviewer.usc.edu/ 

Email: chihinl@usc.edu 

Ph: +1-(213)-740-5813 

http://netviewer.usc.edu/
mailto:chihinl@usc.edu


2. Abbreviations and Terminology 
 

Abbreviations 

 

The followings are used throughout TagBase (in the database) and in this document: 

 

Manufacturers/ Tags 

 Archival or Arc: Archival tags (both Wildlife Computers, Lotek Wireless) 

 LTD: Lotek Wireless 

 MT: Microwave Telemetry 

 PAT: Pop-up archival tags 

 SPOT: smart-position only tags (Wildlife Computers) 

 WC: Wildlife Computers 

 

Wildlife Computers only 

 BinInfo: the definition of values for the 12 or 14 Bins for time-at-depth and time-

at-temperature, depending on tag model 

 FrequencyData: PAT tags time-at-depth and time-at-temperature data 

 

Tables/ Queries 

 Proc: Processed 

 Sum: Summary 

 Tmp: Temporary 

 

Forms/ Graphs 

 Freq: Frequency 

 Pdt: WC PDT worksheet data for PAT tags 

 Wtd: Weighted 

 Temp: Temperature 

 TS: Time Series 

 

Others 

 FTrack_RTE: Position estimates from EASy-FishTracker (FTrack) 

 KF: Kalman filter models (KFSST, UKFSST) 

 Pos: Positions 

 sst: Sea Surface Temperature 

 TrackIt: Geolocation model with light 

 

Terminology 

When you work with TagBase in Microsoft Access, Access offers you Tables, Queries, 

Forms, Reports, Macros, and Modules. Here's a quick overview of what these are and 

when to use them (taken from http://allenbrowne.com/casu-01.html). 

http://allenbrowne.com/casu-01.html


 

Tables. All data is stored in tables. When you create a new table, Access asks you 

define fields (column headings), giving each a unique name, and telling Access the data 

type. Use the "Text" type for most data, including numbers that don't need to be added 

e.g. phone numbers or postal codes. Using Wizards, Access will walk you through the 

process of creating common tables such as lists of names and addresses. Once you have 

defined a table's structure, you can enter data. Each new row that you add to the table is 

called a record. To define relationships between tables, click Database Tools | 

Relationships in Access 2007, or choose Relationships from the Tools menu in Access 95, 

97, 2000. 

Queries. Use a query to find or operate on the data in your tables. With a query, you 

can display the records that match certain criteria (e.g. all the members called "Barry"), 

sort the data as you please (e.g. by Surname), and even combine data from different 

tables. You can edit the data displayed in a query (in most cases), and the data in the 

underlying table will change. Special queries can also be defined to make wholesale 

changes to your data, e.g. delete all members whose subscriptions are 2 years overdue, or 

set a "State" field to "WA" wherever postcode begins with 6.  

Forms. These are screens for displaying data from and inputting data into your 

tables. 

 



3. The Form Navigation Tool 
 

This tool is opened by default when you start TagBase. It allows you to sub-select the 

operations you want to do (e.g. import or export), and takes you to the right place to carry 

out the operation.  

 

 
 

If you have closed this tool and want to bring it up again, you can simply – click on 

Groups > Favorites > NavigateForms 

 

 



4. Import 

 

Before you import any files, make sure you have the following  

 

Essential information needed for Import: 

 

A. TagCode – the serial code of your tag and has to be a unique. This unique code 

will allow us to distinguish a single tag from others. 

B. Date_Deploy – the date time of your deployment 

C. Date_Popoff – the date time of your tag recovery or pop-off 

 

Format of your tag data files: 

 

PAT tag files (.xls) from WC and MT  

 Files should have been processed by the manufacturer software 

 No further preparation is necessary 

 

Archival tag files 

 

 
 

 2 files for each tag.  

 All files must have a header line. 

For Wildlife Computers: 

 File #1 is the time series file (.csv), obtained from Hex-Decoder software 

(see below, Hex-Decoder options for more details) 

 File #2 is the output file (.xls) with location data, obtained from WC-TSP 

software 

For Lotek Wireless (using Viewer 2000 software) 

 File #1 is the time series file (e.g. .BIN.TimeSeries.csv) 

 File #2 is the day log file (e.g. .BIN.DayLog.csv) with location data 

 

ARCHIVAL 
Lotek and Wildlife Computers 

File #1 
• Depth, Light, Temp 
 
File #2 
• Estimated Locations 



What to turn OFF (uncheck) in HexDecoder: 

 

a. Include rows with no sensor data 

b. Hour Markers & Battery Voltages 

c. Deployment/ Duty Cycle Markers  

d. Date Range (off by default) 

 

 

While using (checked): 

 

e. Titles of Fields in First Row 

f. Date Stamps as dd/mm/yyyy (default) 

g. Time stamps as hh:mm:ss (default) 

 

 

 

 

 

 



5 steps to import tag data: 

 

1. Set up a batch job file from the Excel template, TagBaseBatchJob.xlt 

2. Put the batch job file into the folder where your tag data files are 

3. Start TagBase  

4. Set up Binning schemes (only for WC PAT tags) 

5. Import via Batch_Import_TagData form 

 

Step 1 – Setting up the batch job file from the Excel template, 
TagBaseBatchJob.xlt 

 

General outline: Each row of data corresponds to a single tag output file. You can have 

2 or more rows of data for an archival tag or for a double-tagged fish. All essential and 

required fields must be present for each row of data.  

 

IndivID Filename TagCode 
TagPTT

ID TagType 
DateTime
_Deploy 

DateTime
_Popoff 

Lat_ 
Deploy 

Lon_ 
Deploy 

Lat_ 
Popoff 

Lon_ 
Popoff 

BinSample
Interval 

BinID_
Depth 

BinID_ 
Temper

ature 

1 
LTD2310B
2313.csv 050112 bet2313 Archival 07-May-04 26-Dec-04 -1.98 -95.17 -0.52 -94.78       

1 

LTD2310B
2313_050
112DayLo
g.csv 050112 bet2313 Archival 07-May-04 26-Dec-04 -1.98 -95.17 -0.52 -94.78       

2 
BET03900
57.csv 0390057 BET57 Archival 26-Mar-03 22-Feb-04 -1.98 -95.18 0.13 -95.08       

2 
BET03900
57loc.xls 0390057 BET57 Archival 26-Mar-03 22-Feb-04 -1.98 -95.18 0.13 -95.08       

3 

2003_MT_
0006074_
19571_B1
.xls 0006074 19571 MT                   

4 
19374_03
P0550.xls 03P0550 19374 WC             24 1 100 

 

For each tag you import, make sure you have the following Essential fields (5, Yellow): 

IndivID, Filename, TagCode, TagPTTID, TagType 

 

IndivID – This number denotes how many individual fish you are trying to 

import. If you have data for 10 fish, this IndivID should start from 1 for the first 

fish, then increment by one all the way to 10 for each of the remaining fish. The 

same IndivID number can be used for the same fish that carries multiple tags or 

has data from two or more output files. 

 

Filename – This is the filename of the file you are importing. Include the file 

extension (.csv or .xls), but the file directory path (e.g. C:\Data\) is not necessary. 

 

TagCode – This is the serial code of your tag and has to be a unique. Use the 

same TagCode for archival tags where there are two output files for each tag. 



 

TagPTTID – This can be the PTT code you use for Argos transmission, or a label 

of your own. 

 

TagType – This denotes the type of data to import, it must be from one of these 4 

options: WC, MT, Archival, SPOT. 

 

Additional required fields for Archival tags (6, Turquoise): DateTime_Deploy, 

DateTime_Popoff, Lat_Deploy  Lon_Deploy, Lat_Popoff, Lon_Popoff 

 

Additional required fields for Wildlife Computers PAT tags (3, Orange): 

BinSampleInterval, BinID_Depth, BinID_Temperature 

 

BinSampleInterval – This denotes in hours (e.g. 2, 6, 12 or 24), how frequent is 

your time-at-depth or time-at-temperature is being sampled 

 

BinID_Depth – the identifier (any number < 100) that corresponds to a particular 

binning scheme, BinID, having been set in WC_BinInfo table 

 

BinID_Temperature – the identifier (any number >= 100) that corresponds to a 

particular binning scheme, BinID, having been set in WC_BinInfo table 

 

 



Step 2 – Save your batch job file (e.g TagBaseBatchJob.xls) into the 
folder where your data files are located 

 

Step 3 – Start TagBase  

 

Step 4 – Setting up the WC_BinInfo (Wildlife Computers PAT tags 
only) 

You may have used multiple histogram binning schemes for the time-at-depth or time-at-

temperature worksheets. Depending on the tag model as well, there can be 12 or 14 Bins. 

All the binning schemes can be specified in WC_BinInfo table in the following way: 

 

1. Open WC_BinInfo from Tables 

 
 

2. Modify or add binning schemes are explained below: 

 

WC_BinInfo 

BinID Bin BinRange BinMin BinMax 



WC_BinInfo 
BinID Bin BinRange BinMin BinMax 

1 1 <-1.5 -999 0 

1 2 -1.5-5 0 5 

1 3 5-10 5 10 

1 4 10-20 10 20 

1 5 20-40 20 40 

1 6 40-60 40 60 

1 7 60-100 60 100 

1 8 100-150 100 150 

1 9 150-200 150 200 

1 10 200-250 200 250 

1 11 250-350 250 350 

1 12 350-1000 350 1000 

100 1 <5 -999 5 

100 2 5-7.5 5 7.5 

100 3 7.5-10 7.5 10 

100 4 10-12.5 10 12.5 

100 5 12.5-15 12.5 15 

100 6 15-17.5 15 17.5 

100 7 17.5-20 17.5 20 

100 8 20-22.5 20 22.5 

100 9 22.5-25 22.5 25 

100 10 25-27.5 25 27.5 

100 11 27.5-30 27.5 30 

100 12 30-60 30 60 

 

BinID – Unique ID for a particular scheme. By convention, BinID < 100 is used for 

depth, BinID > 100 for temperature. The above example, showed two schemes of 12 bins 

(BinID = 1 for depth and BinID = 100 for temperature).  

 

BinMin, BinMax – fill in the physical values for a specific bin (1-12) 

 



Step 5 – Import via Batch_Import_TagData form 

 

1. You can browse from the Form Navigation Tool > Import > Batch_Import_TagData 

 
 

2. Or, open Batch_Import_TagData from Forms to import 

 

 



3. Follow the instructions on the form to import 

 

 
 

 

 



5. Data Tables and their Relationships 
 

Data Tables 

 

Here are the main groups of table that your data and metadata reside. This is useful to 

know when you are trying to set up your own queries, or modify the data.  

 

Metadata 

 

 FishInfo – Table with information about individual tagged fish, such as species, 

body length 

 TagInfo – Table with Tag Summary Information, including the unique TagCode 

for each tag, deploy and popoff information 

 SpeciesInfo – Table with species standardized name and TSN identifier listings 

 WC_BinInfo - Table with WildlifeComputers Tag Bin classification scheme data 

 

Archival tag data 

 

 Proc_Archival_TempLight – Table with fully processed depth, temperature and 

light time series data 

 Proc_Archival_Location – Table with fully processed WC light-based 

geolocation data (older tag models) 

 Proc_WC_Locations –  Table with fully processed WC light-based geolocation 

data (newer tag models) 

 Proc_LTD_DayLog – Table with Lotek DayLog data (daily summary of 

positions, sst and others) 

 Proc_LTD_MissionDate – Table with Lotek data that matches up mission day 

(day at liberty) with a Date (mission date) 

 

Microwave Telemetry PAT 

 

 MT_ObservationTypes – Description of ID fields used in Microwave Telemetry 

Processed Depth Temperature table, Proc_MT_DepthTemp 

 Proc_MT_DepthTemp – Table with fully processed MicrowaveTelemetry 

Pressure & Depth Data 

 Proc_MT_GPSdata – Table with fully processed Microwave Telemetry Argos 

Data 

 Proc_MT_Location – Table with fully processed Microwave Telemetry 

manufacturer light-based geolocation data 

 



Wildlife Computers PAT 

 

 Proc_WC_FrequencyData – Table with fully processed Wildlife Computers 

Time-at-Depth and Time-at-Temperature data 

 Proc_WC_Locations – Table with fully processed WC light-based geolocation 

data 

 Proc_WC_LocationsLight – Table with fully processed Wildlife Computers 

manufacturer light data in the Locations worksheet 

 Proc_WC_PDT – Table with fully processed Wildlife Computers PDT Data  

 Proc_WC_Status – Table with fully processed Wildlife Computers Argos data 

from the Status worksheet 

 

If you want to know the details about any of the above tables, you can select that table 

and click Design 

 

 
 

And a detailed list of fields with their descriptions will be shown 



 
 

Relationships 

 

Relationships are a key feature of database systems and allow us to specify how data 

fields are related to each other among various tables. In TagBase, there are two key 

relationships that link up all data: 

 

1. FishInfo table  TagInfo table 

2. TagInfo table   All downstream data tables 

 

1. FishInfo table  TagInfo table 

 

These two tables are linked by the FishID field, which any individual fish you have 

imported data for should have a unique FishID (a number). For each FishID, i.e. a 

distinctive individual, you can one or multiple tags, as represented by a unique TagID. 

For example, you can have a fish, FishID = 5, carrying two tags, TagID = 10 and 11.  

 

This way, metadata can be added to the FishInfo table or new tables that are linked to the 

FishInfo table; while, tag data are related back to an individual fish through TagInfo. 



 
 

Example Case: Modify the species information of a newly imported 
fish 

 

Scenario 

When you have imported a new tag from a new fish using the Batch_Import_TagData 

form (see Import), this new fish will be assigned a new FishID (= 8, in this example) in 

the FishInfo table. By default, since TagBase has no idea which species this new fish is, 

this fish will be associated with a SpeciesTSN = -999 in the same FishInfo table.  

 

This SpeciesTSN corresponds to a record in the SpeciesInfo table. Open the table and 

you can find a record for SpeciesTSN = -999. Obviously, you may want to describe your 

species better than “Generic fish”. So you can add a new record in this table, such as the 

below example. 

 

SpeciesInfo 
SpeciesTSN CommonName ScienceName 

-999 Generic fish Fishie fish 

159903 White shark Carcharodon carcharias 

 

Now, go back to the FishInfo table, and enter the new SpeciesTSN = 159903 for FishID 

= 8, and your fish will be associated with “White Shark” instead. 



 

FishInfo 

FishID SpeciesTSN Length Weight Sex HookType TissueSample Condition Notes 

8 159903 200 350 Male J No   

 

2. TagInfo table  All downstream data tables 

 

Data from a tag file are stored in multiple tables, for example, for an archival tag, the 

depth-temperature-light time series data are stored in one table, while the location 

estimates are stored in another table. TagInfo table connects all these data tables together 

through the TagID field. Every individual tag you import will have a unique TagID (a 

number), and all the data for that particular tag will be associated with the unique TagID. 

In this way, data that belong to one tag can be obtained from different data tables using 

its TagID.  

 
 

If you want to know all the relationships in TagBase, you can bring up the Relationships 

diagram by using the toolbar button, as shown below: 

 



 
 

 

 

 



6. Display and Graphs 
 

The Display/ Plot forms have pre-set graphs that plot your tag data. A variety of plot 

forms, along with a specified description of what are being plotted, are accessible through 

the Form Navigation Tool > Plot. Examples of these plots include: 

 

• XY/Time Series 

• Histogram 

• Bubble Plots 

 
 

 
 



Tips on using Plot forms 

 

 When Microsoft Access displays the following error message “An error occurred 

while sending data to the OLE server (the application used to create the object”.  

(see below) when you open a form,  

 

Just click OK. Nothing has gone wrong; it is just an obscure glitch in MS Access.  

 

 
 

 Close an existing plot form before you start up a new one 

 

This avoids conflicts before forms and keeps things running smoothly 

 

 To see the plotted data in a spreadsheet view, double-click anywhere on a graph. 

 

You can copy the data to clipboard and plot it in Excel or other software 

 

 



 To modify the graph properties, right-click anywhere on a graph, and select 

from the pop-up menu. Graph properties are similar to those in Excel. 

 

 
 

 To change the X or Y-axis (or gridlines), right-click on an axis (a gridline), and 

select Format Axis from the pop-up menu. 

 

 
 

 To make a snapshot of the graph, just click on the graph, and press Ctrl+C or 

Edit > Copy Chart from the menu. 



Points to note on specific Plot forms 

 

Plot_WC_BubbleTS_DepthTempFreq 

 

 Bubble-sizes from a single column represent the Time-at-Temperature or Time-

at-Depth values (which add up to 1) from a time period  

 Y-values are lower bound values, which corresponds to BinMin values from 

WC_BinInfo table 

 In the Depth plot, Y-values are BinMin + 1; this is done only to enhance 

visualization. 

 

Plot_WC_PdtBubbleTS_TempMidRangeVsDepthClass, 
Plot_WC_PdtTS_TempMidRangeVsDepthStratum 

 

 Median temperature is calculated from (Min Temp + Max Temp)/ 2 for each PDT 

class (8 in total) 

 

Plot_ARCHIVAL_DepthTempLightTS 

 

 Only max. 65000 records can be plotted at any time, an overflow error will be 

displayed if the maximum number of records to be plotted is exceeded. 

 



7. Export 
 

1. From the Form Navigation Tool, select Export from Operations, and then 

Export_TagData 

2. Follow the instructions to export data. 

3. Required fields: TagID and Export Type. 

 

4. Optional fields: File Name, Folder Path and Depth Filter (WC PAT only). 

5. Depth Filter is only used when SST data are coming from Proc_WC_PDT, 

instead of Proc_WC_Locations 

 

 



8. Other Resources 
 

 

 

 

 



9. Troubleshoot 
 

Error message: "Undefined Function Date( ) in expression" 

 

For a number of people who have Access 97 Databases and have now converted their 

legacy databases to Access 2000 (or from 2000 to 2003) you may find that you will 

experience above error. You may have a variation on this error message stating that an 

object or reference is missing also the error message that you may get could be for 

another function other than the Date ( ) function.  

 

When: On startup 

 

Solution:  

 

 1. Launch Microsoft Access 2000.   

 2. Navigate to and Open TagBase.   

 3. Click on the Modules option within the Objects section of the Database 

window (fig 1.0)   

 

   
Fig 1.0 Database Window Screen   

 4. Click on the   button to start the creation of a new module and the 

Visual Basic Editor Window will be displayed on the screen, or double-click on 

an existing one on the right.   

 5. From the Tools drop-down menu select References (fig 1.1)   



 

   
Fig 1.1 References option from the Tools menu   

  

 6. Once you have selected the References option the following References Dialog 

Box will be displayed (fig 1.2):   

 

   
Fig 1.2 References Dialog Box   

 7. You will notice within the References dialogue box that you will have one or 

more MISSING references (Fig 1.2 indicates a missing reference).   

 8. For each and every missing reference that you have remove the tick from the 

  box to the left of each library reference line.   

 9. You now need to scroll down the list until you reach the Microsoft DAO 3.6 

Object Library reference and place a tick into the    box.  

 10. To resolve all the legacy problems that deal with invalid object 

references/functions/library errors you need to replicate the following Reference 

Dialog box (Fig 1.3) to mirror your own. Pay particular attention to the order of 

the references within the list as the Microsoft DAO 3.6 Object Library needs to 

be above the Microsoft ActiveX Data Objects 2.1 Library .   



 

Note: If you are missing any of the references contained within the list you need to scroll 

down the list and find each of them in turn and place a tick in the   box to the left of 

each reference line until you get a complete list as illustrated.  

   
Fig 1.3 Reference Dialog Box displaying correct library References   

 11. Once you are satisfied that your list of references mirrors the list contained 

within fig 1.3 click on the    button to accept your revised references 

list.   

 12. Click on the Save button to save the module. The name that you give the 

module is irrelevant you can leave the name as the default and click on the 

   button to confirm the save operation.   

 11. From the File Menu select Close & Return to Microsoft Access to Exit the 

Visual Basic editor.  

 

 

 


